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Welcome to ClarisWorks

Using This Book

W-2

Welcome to the ClarisWorks ~ application from Claris Corporation. ClarisWorks
is an integrated software package designed to give you everything you need to be
productive: a natural computing environment and the right tools for the job.

ClarisWorks documents share functions and features with other Claris® products.
If you’ve used the MacWrite®, FileMaker®, or MacDraw® applications, you'll
find many similarities.

If you use another Claris product later, such as the FileMaker Pro, MacDraw Pro,
or Claris Resolve " applications, you can draw on what you learn with ClarisWorks
documents to move quickly into those products.

This book provides step-by-step instructions and reference information. You

need not read the whole book, but only those sections or chapters you need for
information on specific tasks.



Onscreen Materials

T'he ClarisWorks User’s Guide presents information in the following ways:

Boldfaced words in the text are defined in the glossary.

¢ Note messages look like this paragraph, and give extra information about a
procedure.

¢ Tip messages look like this paragraph, and provide helpful information or
describe a ditferent way to do something.

¢ |mportant messages look like this paragraph, and warn you when you
cannot undo an action, or when an action may cause you to lose data.

In addition to this book, ClarisWorks comes with several sources of onscreen
information. ClarisWorks Help and Apple Balloon Help provide quick access
to information about ClarisWorks. Sample documents can serve as examples
of ClarisWorks teatures and as templates you can use to get started working in
documents quickly.

About ClarisWorks Help 3

ClarisWorks Help gives you onscreen instructions and reference information
you can use while you’'re working with ClarisWorks documents. Onscreen
help means that you have direct access to the help system on the computer
screen, as you work. Because the system 1s computer-based, you can easily
search for topics and move quickly from one topic to another. The help system
covers numerous selected topics, including spreadsheet functions.

Using the ClarisWorks Help System

If you’re like many new computer users, you may be cautious about using
onscreen help because you feel more familiar with printed books. ClarisWorks
Help is simple to use. The more you explore it, the more comtortable you'll feel

about using it.

Opening ClarisWorks Help

You can leave a ClarisWorks document open as you look up topics in the help
system. You can then switch back and forth between a ClarisWorks document
and a help screen when you need more information.

Welcome to ClarisWorks W-3



Buttons

W-4

To open ClarisWorks Help:

1. Choose Help from the Apple menu (or press Command-? or, on an extended keyboard,
press Help).

In System 7, choose ClarisWorks Help from the Help menu (the question
mark in the upper-right corner of the screen).

You see the help window at the first card, an interactive table of contents
for the system. The topics you see are actually buttons—screen elements
you click to move to the topic.

B———— Clarislorks Help &=—
&i Contents

Using Help

Clarisworks Basics

word Processing Documents
Draw Documents

FPaint Documents
Spreadsheet Documents
Database Documents
Communications Documents
Using Advanced Features
Functions Eeference

Index

Customer Support Information

Llick 8 lopic for more information.

2. If you need instructions on how to use the system, click Using Help.

The Using Help series shows you how the system is organized, how to
move about 1n the system, and how to find the information you want.

3. After you review the instructions, click Contents and then click any topic.
You see the first card in a series related to the topic you clicked.

You can continue to open, close, and work with ClarisWorks documents
while the help window is open.



Working with the Help Window

You can move the help window to a different part of the screen to make it more
convenient to read as you work. To move the help window, drag it by its title bar.

To arrange windows for easy access, drag ClarisWorks document windows and
the help window 1nto a “stack,” so the corners overlap. Then, you can click a
corner of any one of the stacked windows to bring that window into view.

To close the help window, click the close box in the upper-left corner of
the window.

Using Balloon Help

If you are running Apple System 7 software or later, you can use Apple
Balloon Help to see brief descriptions of ClarisWorks tools, as well as

information about system i1cons and menus. Help balloons are preset to be
hidden from view.

To use Balloon Help, choose Show Balloons from the Help menu (the question
mark in the upper-right corner of the screen). Show Balloons alternates with
Hide Balloons in the Help menu.

ClarisWorks Samples

Included with ClarisWorks are several sample documents (sometimes called
templates). These samples give you a head start on producing your own
documents, and also show you ways to get the most out of ClarisWorks.

What's New in ClarisWorks

If you’re familiar with an earlier version of ClarisWorks, you may want to read
this section for an overview of new features. This section lists new features and
tells you where you can find detailed information and step-by-step instructions.
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General Enhancements

ClarisWorks includes new features that make working in documents more
convenient 1n all its application environments.

Now you can...

For more information, see...

Choose from more tools on an enhanced tool
panel.

“ClarisWorks Tools™ 1n chapter 1.

Set up and use custom text styles.

“Using Custom Text Styles™ in chapter 2.

Use the page indicator to navigate directly to
the page you want.

“Going to a Page” in chapter 2.

Collapse palettes to make more room on
the screen.

=—

“Fill and Pen Palettes™ in chapter 1.

Choose among 256 editable colors.

“Setting Preferences” in chapter 2.

Create custom fill and line patterns.

“Editing Colors, Patterns, and Gradients” in
chapter 4.

Create custom gradients.

“Editing Colors, Patterns, and Gradients™ in
chapter 4.

Customize documents with more preferences
settings.

“Setting Preferences” in chapter 2.

Use predefined shortcuts to accomplish tasks
quickly.

“About ClarisWorks Shortcuts” in chapter 8.

Play macros quickly by clicking a button on a
palette.

“Using Macros” in chapter 8.

Present a shide show from your computer.

“Creating a Slide Presentation” in chapter 8.

Quickly open stationery when you create a
document.

“Creating a Document” in chapter 2.

Use System 7 Publish & Subscribe to share
data with other applications and computers.

“Using Publish & Subscribe” in chapter 8.

Play QuickTime movies.

“Working with QuickTime Movies” in
chapter 8.




Text Environment

The ClarisWorks text environment has new outlining capabilities. Other
enhancements make it easier to work with text in columns and arrange text
in a document or frame.

Now you can... For more information, see...

Outline text in word processing documents and “Working with Outlines” in chapter 3.
text frames. This 1s useful for organizing

information, indenting text, and arranging text

so you can hide certain parts of your document

from view.

Use column controls to change the number of “Adding Columns Using the Ruler” in

columns in a document quickly. chapter 3.
Resize columns manually. “Modifying Columns Using the Mouse” in
chapter 3.

Check the spelling of only text that i1s selected. “Using the Spelling Checker” in chapter 2.

—

Wrap text around objects and pictures. “Adding Pictures as Objects™ in chapter 3.
Show or hide invisible characters. “Displaying Formatting Characters™ in
chapter 2. N

Add soft returns to control line breaks without “Using Formatting Characters™ in chapter 3.
starting a new paragraph.

Use the Strike Thru text style to format text. “Changing Text Appearance” in chapter 3.
Use fill (repeating) characters with tabs. “Working with Tab Markers” in chapter 3.
Add a custom amount of space before and after “Changing Paragraph Spacing” in chapter 3.
paragraphs.

Draw Environment

If you worked with graphics documents 1n a previous version of ClarisWorks,
you will find that you can do the same things in draw documents. The draw
environment has all the features you are familiar with, plus a few new ones.

Now you can... For more information, see...
Draw objects with any combination of sharp  “Drawing Bezier Curves™ in chapter 4.

and smooth points using the bezigon tool.

Draw symmetrical shapes such as hexagons “Drawing Polygons™ in chapter 4.
with the regular polygon tool.
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Now you can... For more information, see...

“Pick up” an object’s attributes (color, pattern, “Picking Up an Object’s Attributes” in
pen width, and so on) in your drawing and chapter 4.

apply them to another object using the

eyedropper tool.

Frame the edges of an arc to create pie-shaped “Reshaping Arcs™ in chapter 4.
wedges.

Specify the exact size and placement of objects. ““Arranging Objects’ and “Resizing Objects™ in

chapter 4.
Select multiple objects for editing. “Selecting Objects™ in chapter 4.
Use a master page to give the pages ot your “Working with a Master Page” in chapter 8.

document a common appecarance.

Paint Environment

ClarisWorks has a new document type—paint. In the paint environment, you
can use all the tools you know from the draw environment plus a set of painting
tools for special etfects. Use the paint environment to make freeform shapes in
a variety of textures, or to refine an illustration to the smallest detail. For more
information on painting, see chapter 5, “Working with Paintings.”

Spreadsheet Environment

When you work 1n a spreadsheet document, you have more options for
customizing the way you work with spreadsheet data. You also have more
options when you chart data in a spreadsheet document.

Now you can... For more information, see...

Add solid borders to cells or solid lines to just “Adding Borders™ in chapter 6.
the edges you choose.

Wrap lines of text within a cell. “Wrapping a Cell Entry” in chapter 6.

Lock a spreadsheet row or column to repeat a  “Splitting the View and Locking Titles” in
title on every page. chapter 6.

Copy and paste cell formats. “Cutting, Copying, and Pasting” in chapter 6.

Create more types of charts, combine different “Displaying Data in Charts” in chapter 6.
chart types in a single chart, and format charts
in different ways.




Database Environment

When you work 1n a database document, you have more control over how you
enter data. You also have more convenient ways to print labels.

Now you can...

For more information, see...

Automate how you enter data in database fields
by creating pop-up menus of choices, letting
ClarisWorks enter a value for you, and setting
a field to check the data after it’s entered.

“Customizing Fields for Data Entry” in

chapter 7.

- —_

Format labels in more ways and choose among
preset Avery label formats.

“Creating Labels™ in chapter 7 and appendix C,
“Printing Labels.”

Insert the contents of another document into a
database and “map” information into the
appropriate fields.

“Inserting Database Documents from Other
Applications” in chapter 7.

Share data with files created in the DBF
(dBASE) format.

“Importing, Inserting, and Exporting
Documents” in chapter 2.

Communications Environment

When you work 1in a communications document, you will find that &
communicating with other computers and with online services 1s more
convenient than in previous versions of ClarisWorks.

Now you can...

Set preferences options to automate frequently
used communications settings.

For more information, see...

“Setting Preferences” in chapter 2 and “Setting
Communications Preferences” in chapter 9.

Open an overflow area (scrollback pane) to
store incoming data that doesn’t fit in the
working area of your communications
document.

“About the Scrollback™ in chapter 9.

Conduct multiple communications sessions at
once, with each session 1n i1ts own window.

“Creating a Communications Document” in
chapter 9.

Print a session right from the communications
environment.

“Printing Your Work™ in chapter 2.

=

Look up frequently used numbers 1n a custom
phone book.

“Using the Phone Book™ 1n chapter 9.

Welcome to ClarisWorks
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Chapter 1

ClarisWorks Concepts

About ClarisWorks

1-2

This chapter introduces you to ClarisWorks documents, tools, and windows.
It is not a how-to chapter. For instructions on using different document types,
tools, and features, see chapters 2 through 9.

The ClarisWorks application 1s an integrated software package that provides a
natural computing environment. “Natural” means you can work on ClarisWorks
documents the same way you work with a pencil and a sheet of paper. When

you’re writing a letter or report, for example, you can sketch a drawing just as if
you were working by hand.

ClarisWorks 1s easy to learn and use. It’s also a power base for advanced
computing when you’re ready to tackle projects like “what-1f”’ analyses 1n a
spreadsheet or conditional searches in a database. You'’ll find a lot of accessible
computing power in the ClarisWorks program.



Now, with a single application, you can do the jobs most frequently performed on
a personal computer: word processing, outlining, drawing, painting, database
management, spreadsheet work, charting, presentations, and telecommunications.
You don’t need to switch from one application to another to do a different task.

Different Document Types

You can create six different types of documents in ClarisWorks. Each type of
document is primarily for a specific kind of work such as writing a letter or
drawing a picture. You work with each type of document in a ClarisWorks
application environment, such as word processing or drawing.

Draw Database

Spreadsheet AN Communications

When you create a document, it appears in 1ts own special window, with the
tools needed for that document type. (If you need help understanding windows,
see “ClarisWorks Windows” on page 1-19, and the documentation that came

with your Macintosh.)
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Word Processing (Text)

You use a word processing document primarily to write and format text.
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Above the word processing window, you see the word processing menus and,
below the document title, the text ruler. You use the text ruler to set indentation,
tabs, line spacing, text alignment, and columns. (For more information on
rulers, see “Changing Ruler Settings” in chapter 2.)

The working area is the part of a document that contains what you type or
draw. In this case, the working area 1s the space you use to write text or to add
other objects to a text document.
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A word processing document is useful for projects like these:

At the office At home

Composing letters, memos, and general Writing holiday and family letters
correspondence

Outlining and writing business reports and Outlining and writing school reports

research papers

————— —_——— ——— === —_—

Writing newsletters, articles, and bulletins Keeping personal journals
Drafting legal contracts and documents Keeping club minutes
Printing personalized form letters Writing a family history

Writing a business plan

ClarisWorks gives you great flexibility in the way you present what you write.
Using multiple columns, for example, you can create protessional-looking
catalogs and reports. You can take the sting out of research papers by using
spreadsheet capabilities to format tabular text, and tfootnotes that number and
renumber automatically.

-
For more information on word processing, see chapter 3, “Working with Text.”
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Graphics rulers

Drawing tools

Fill and pen palettes

Working area

1-6

Drawing

You use draw documents primarily for artwork and page layout. A draw
document is made of objects such as rectangles, circles, lines, and polygons.
Each object is a separate element that you can select, move, and modify. With
the fill and pen palettes, you can change an object’s pen (line) width and fill

color and pattern or gradient.

(& File Edit Format Arrange Options Uiew

T

Notice the different menus, Arrange and Options, in the draw document.
Menus change when you change application environments, so you have access
to the appropriate commands when you need them. The gridlines you see in the
working area, along with graphics rulers, help you draw objects and align
them precisely.



A draw document is a good choice for projects like these:

At the office At home

Creating newsletters and brochures Creating club and organization announcements

Creating professional-looking business forms Creating party invitations

Developing organization charts Documenting the family tree (genealogy)

Developing office and facilities layouts Doing furniture-arrangement diagrams

Creating sales bulletins and direct mail pieces Creating school artwork

Creating and presenting a slide show

For more information on drawing, see chapter 4, “Working with Drawings.”

¢ Tip Draw documents are especially useful for complex page layouts—you
can add text frames to a draw document and link them together so the text
flows from one frame to the next. For more information on frames, see
“Putting It All Together” on page 1-13 and “Working with Frames™ in
chapter 8.
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Painting
You use paint documents primarily for creating illustrations. Y-ou can use the
same tools as when you create drawings, plus a set of tools for special effects
like paintbrush strokes and spray paint. A paint document is made of images—

shapes and visual effects that, if you look at them 1n a magnified view, are
composed of tiny squares called pixels.

€ File Edit Format Transform Options Diew

Painting tools

Working area

Pixels of the painting
(400% magnification)

A paint document 1s a good choice for projects like these:

At the office At home

Creating artwork for brochures and newsletters ~ Creating illustrations for personal stationery

—

Creating 1llustrations for reports Creating school artwork

———=

Designing logos Designing a family coat of arms

For more information on painting, see chapter 5, “Working with Paintings.”



Spreadsheet

With a spreadsheet document, you can perform financial or scientific
calculations, create professional-looking reports, and organize numeric
information. You can use a spreadsheet to present any type of information
that’s suited to a columnar format.

If you want to turn numbers into pictures for quick comprehension, you can
turn the numbers into charts. You can then dress the charts up with different fill
colors and patterns.

" &% File Edit Format Calculate Options Uiew
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In a spreadsheet document, you type and edit data in the entry bar. When you
confirm an entry, what you typed appears in a spreadsheet cell (the intersection
of a column and a row).
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A spreadsheet document 1s good for projects like these:

At the office At home

Analyzing financial performance Setting up a home budget

Analyzing and comparing loans Tracking a mortgage or car loan
Maintaining a checkbook Managing checkbooks and savings accounts
Managing business assets Managing personal assets

Analyzing stock performance Tracking performance of stocks and bonds
Maintaining tax records Documenting tax-related expenses

Creating sales and market forecasts Charting the children’s growth

Creating expense reports rTrack{ng and charting sports statistics 3

Producing income statements (P & Ls)

For more information on spreadsheets, see chapter 6, “Working with
Spreadsheets.”
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Database

Database documents are useful for managing and organizing large collections
of information. In a database document you can accumulate information, sort
1t, and print attractive reports. You can also perform sophisticated searches to
find and work with only the information you want. By creating different
layouts (views) of the data, you can organize and present the same data in many
different ways.

€ File Edit Format Layout Organize Uiew
i=——————— Natabase B} =———————— @i
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The book and status area help you move through the document and keep track
of what you’re doing.
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A database document is a good choice for projects like these:

At the office At home

Maintaining a business contacts list Maintaining address and telephone lists
Maintaining customer lists for automated Cataloging household furnishings for
mass mailings Insurance purposes

Printing mailing labels from the customer list ~ Printing mailing labels for a family letter

Tracking sales, markets, channels, and Keeping track of your favorite recipes
product lines

Managing time and logging billable hours Creating bibliographies for school reports

Controlling inventory Cataloging CDs, video or audio tapes,
and records

Cataloging acquisitions such as collectibles
or stamps

Maintaining personnel records

For more information on databases, see chapter 7, “Working with Databases.’

Communications

A communications document 1s different from other ClarisWorks documents.
[t conducts a communications session between your Macintosh and an online

information service, bulletin board, or another computer.
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With a communications document, you can connect to a remote computer and
recelve, send, and save data. Options are preset for most commonly used
settings, so all you usually have to do is add the telephone number.

Using ClarisWorks as a communications tool, you can work on projects

like these:

At the office At home

Tapping into stock quotes and financial summaries Doing research for school reports
Checking airline schedules Shopping

Doing literature searches from your Macintosh Finding new games for your computer
Getting computing tips and ideas from user Joining a hobby-related bulletin-board
bulletin boards discussion

Exchanging ideas on education-oriented
bulletin boards

For more information on communications documents, see chapter 9, “Working
with Communications.”

Putting It All Together

Although you begin working with a specitic document type, you can add
frames that use features of other application environments. A frame is a special
kind of object. When you add a frame, you set aside an area in a document for
a different kind of information—try thinking of a frame as a document within
a document.
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For example, you can add a spreadsheet frame to a text document and use the
spreadsheet for calculations—just as if you were in a spreadsheet document.
You can open the spreadsheet to a full window from within the text document
if you need more room to work. When you print the text document, the
spreadsheet prints as part of it. You only have to work with one document,
because the spreadsheet is integrated into the text document.

Frames give you all the tools ——
from other document types in
the current document.

Besides combining application environments by using frames, you have
several other advanced capabilities that help you automate your work:

»  Mail merge—Customize mailings by combining information stored in a
database with a word processed letter.

s Slide show—Make a presentation directly from ClarisWorks on your
computer. Use a master page for a common background on each slide.

s Shortcuts and macros—Increase your productivity by reducing long tasks
to a single step.

w System 7 Publish & Subscribe—Share data with other software applications,
and send and receive updates automatically when the data changes.

For more information on these topics, see chapter 8, “Using Advanced Features.”
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ClarisWorks Tools

Much of the work you do in ClarisWorks involves the tool panel— a collection
of tools at the left side of the document window. Each tool represents
something you can do in ClarisWorks, such as drawing a line, coloring a circle,
or adding a frame to your document.

Just as the menus change, the appearance of the tool panel changes depending
on which environment you are in. For example, you see a different set of tools
in a paint document or frame than you see in a spreadsheet.

Environment tools

Drawing tools

Painting tools

Fill palettes

Pen palettes

You can show or hide the tool panel in most documents. (In a database
document, tools are only available in Layout view.) For more information on
showing and hiding the tool panel, see “Showing or Hiding Tools and Rulers”
in chapter 2.
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Environment Tools

Use the environment tools to add text, spreadsheet, or paint frames to the
current document, or to switch to another environment in the current document
if a frame for it already exists. You don’t need to add a frame to draw objects—
ClarisWorks puts you in the drawing environment as soon as you click the
arrow tool or select one of the drawing tools. The environment tools are always
available when you can see the tool panel.

Tool Environment Pointer
Drawing Arrow
Text (for word processing) I—‘beam
Spreadsheet Crossbar

Painting Brush

——

You add a frame by choosing an environment tool and drawing a rectangle on
a page in your document. Inside the frame, you have the appropriate pointer
and all the tools of that frame’s application environment. If you go back into
the original document and then select the frame, you see handles on the frame’s
border. A frame with handles 1s just like any other object—you can cut, copy,
paste, and resize it.

For more information on frames, see “Working with Frames™ in chapter 8.

Drawing Tools

Use the drawing tools to draw objects such as lines, ovals, and rectangles in a
document. With the arrow pointer, you can select, move, and resize objects.
These tools are always available 1n a draw document, and are usually available
in other application environments (except communications and some of the
database views).

Drawing tool Use to...

Draw a straight line.

Draw a rectangle or square.

Draw a rounded rectangle or rounded square.

- —_— — —

1-16



Drawing tool Use to...

Draw an oval or circle.

Draw an arc that curves between two points.

Draw 1rregular shapes composed primarily of angles and
straight lines, such as triangles and stars.

Draw a freeform shape composed of curving or nrregular
lines, like a shape you draw with a pen or pencil.

Draw an irregular shape composed of lines and angles, with
control points for precise shaping.

Draw a regular shape with sides of equal length, like a
hexagon or octagon.

Pick up the attributes of an object.

For more information on drawing, see chapter 4, “Working with Drawings.”

Painting Tools

The painting tools build on the set of drawing tools by providing special effects
and more control over details. These tools are only available in a paint -
document or frame.

Painting tool Use to...

Select a rectangular area.

Select an irregular area.

Select adjacent pixels of the same color.

Paint strokes of various shapes and sizes.

Paint fine lines.

Fill an enclosed area with a color, pattern (or both), or
a gradient.

Create an airbrushed or spray painted effect.

Erase part or all of an image.

For more information on painting, see chapter 5, “Working with Paintings.”
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Fill and Pen Palettes

A palette is a window with options you can apply to an object or image you
create. With the fill and pen palettes, you can change the fill color, pattern, or
gradient of an object or image; and the pen width, color, and pattern of the lines
that form the borders of an object or image. You can also add arrowheads to lines.

Fill /Pen color palette =l Gradient palette
Pen width palette [ i s [T}
one
Hairline
v 1 pt.
2 pt.
® ase———— X 0t
Fill/Pen pattern palette —
| , N C pt
:12221 : . C ot
;5;.;5;;;&;; her..
EE;[E
- IEENE|={ Arrows palette  [O7 Arrows 153
E-...Eﬁ . B ING v’ Plain Line
e [S75 o Arrow At Start
E 2K Em - Arrow At End
A Arrows At Both Ends

You can work with palettes directly from the tool panel, or by “tearing” the
palette from the tool panel and moving it to another part of the screen. Once the
palette 1s open, you can collapse 1t so only the title bar 1s showing. Doing so 1s
useful when you want to keep the palette on your screen without closing it.

To tear a palette from the tool panel:

1. Point to the palette’s icon in the tool panel and press the mouse button to open the palette.
2. While the palette is open, drag it away from the tool panel.

3. When the palette is positioned where you want it, release the mouse button.

The palette stays open in tfront of your document. You can drag the palette
by its title bar to move 1t anywhere on the screen.

To collapse a palette, click the control in the upper-right corner of the palette.
The palette’s contents are hidden, and you see a bar with the palette’s name in
the upper-right corner of the screen. To reopen the palette, click the control
again. Option-clicking the control collapses or expands all open palettes.
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To close a palette, click the close box in the palette’s upper-left corner.
Option-clicking the close box closes all open palettes.

For more information on working with fill and pen palettes, see “Changing
Object Fills and Borders” in chapter 4.

ClarisWorks Windows

The contents of a ClarisWorks document show in a window, with the name
of the document in the title bar and standard controls for closing and resizing
the window.

Other controls are specific to ClarisWorks windows. Use the horizontal and
vertical pane controls to separate the window into smaller working areas that
can show ditferent parts of the same document. With the show/hide tools
control, you can show or hide the tool panel. Use the zoom controls to rescale
what you see in the working area, and the page indicator to navigate to a page.
For more information on using the controls, see “Working with Document
Windows™ 1n chapter 2.
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Horizontal pane control

o ) L v e O L B R e i g s ar, ¥ R e A e i i i P e o e i 0 L B he B o= b T o Fadi et L e P R A sl EE i L
r - . A T S 'y - 0 - - o = T - S . 3 . ] - v - ol -~ v - - - - = L - N . P L - = .’ g A Lo . i - oy - e - & - P e -t o - .. Py o
3 E L 3 il o - [ E ] s i . . 'l
X " .
- n . ki, 5 ' . _ - e e - —— = = - ¢ - e ' b - ey e e Py o ¥ 5 T T " T 5 = T ————— ey ) x

- e - 5 hE LT E R T r e e e . 'y 5 - ¥ i Ny i ¥ P ¥ = ¥ s . - E - L%

L T I i T — o L R = =T . N B : . - s = -~ " - R N iy | - r‘ T t o £ ¥ .

S =i = e = T el . er T e ) T T ey i - e e royly ey e ok i Cr e Sty e e T o P e e gy - S g™ P — M
s - B ek e B R A & - 3 ¥ = . 3 ' £ - . : : i ik e Al Seci el e rpar T iy s o = iyl iy r iy el i i =y Sty = 4
- .. 1 M F T T A e R 1 5 =R ' e e . L e e R A R ke ey e o T e o AT . A TR o g g T RN T - A - _
e e Aomnni - - 5 o s s A £ i i v frY TR YL & v . J R e 5 d . T .y Sty K" - K e N N oy e ol iy o S ) K ot 3 N ey
—_—

R et Bt S el
A e
S R .
R . _';'.:.';.‘:‘:“:;-_:-_.;.;7.; o Tl
Ll e ;_-\.:'::- . :.-‘ a0, e l-:hbi.lu_ AL -\,;.-:n.'.?::_"'h{q oy '-.;:“'.

ot

oot

A

3
=
.\
'l.:'l.
ni
SEy

-

-

c
-
e
i
i
',
-
3F
5
-1 Ny
o l-:‘:'t
SREte
- _"
‘::"‘E’
-
-
o '~
LS
- l"
L]

1 R S |
' |
| :
I i
| I
!
|
|
f
- I
‘ |
L ] t I i|
ow/ niae 100Is CoNiro |
:
|

s e el i (e e W - Ty g A L e N sl ;-_:_L-:r.-,._'.:":'t-j- A PEEETAT s _|. A ER “':‘-’-:"{""":-"-:"l R ,.: A LR SnEs R RERRE g : s :‘._;u ok aLEEY : it y s PEX v et |: . 1.‘_‘.‘_ ot frs]

100 ] A 4B N Page t 0000 gl ciiiiasiiaaiiaan et s s ie s G iy AR B SRR SRR
LA V| | R R e e N SRR AR R R R T R R R N R R R R N R R R

Zoom controls e |
Page indicator Vertical pane control

The page indicator shows the current page number. If you double-click the
page indicator, you can navigate directly to a page. For more information on
navigating to a page, see “Going to a Page” in chapter 2.
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If you are using a master page (in a draw document), the page indicator shows
the text “Master Page” instead of a page number. For more information on
using a master page, see “Working with a Master Page” in chapter 8.

You can have more than one window open at a time, and open multiple views
of the same document. For information on views, see “Working in Views™ 1n

chapter 2.

Where to Go from Here

1-20

This chapter provided an introduction to ClarisWorks elements. The rest of the
manual gives step-by-step instructions for creating and working with ditferent
types of ClarisWorks documents.
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Chapter Lem

ClarisWorks Basics

This chapter gives step-by-step instructions on activities that are common to text,
draw, paint, spreadsheet, and database documents. Some of these activities are
also common to communications documents.

Managing Documents

2-2

A document is a Macintosh file created by an application. In the ClarisWorks
application, you can create and work with six different types of documents, each
of which 1s designed primarily for a specific task—word processing, drawing,
painting, spreadsheet work, database management, or communications.

This section describes how to open, save, print, and close documents. It
also explains how to share ClarisWorks documents with other applications

and how to save documents as stationery—templates with text or settings
you use frequently.



Creating a Document

Clarizworks

Application icon

You can create a document when you first start ClarisWorks, or after
ClarisWorks is already running.

The type of document you choose to create depends on the kind of work you
plan to do. For a brief description of the document types, see “Different
Document Types™ in chapter 1.

When You Start ClarisWorks

To create a document when you first start ClarisWorks:

1. Double-click the ClarisWorks application icon (or select the icon and choose Open from the
File menu).

You brietly see the ClarisWorks start-up screen, and then you see the New
Document dialog box. The preset document type is word processing.

o T D T R P IR P T R T F R A o T T e T e Y T L T e e e e e e e a8 N o M s e A e

New Document

@ Word Processing () Spreadsheet ~
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[Eance!] [ 1] 4 }

i
E
P
E
;
5
£
£
3
4
;
ij.
E.
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2. Select the type of document you want. Or, if you want o open a new copy of a stationery
document, choose from the Stationery pop-up menu.

¢ Note The Stationery pop-up menu lists all the stationery documents that
are stored 1n the ClarisWorks Stationery folder (in the Claris folder of your
System Folder). If you prepared an options stationery file, you can prevent
it from opening by holding down the Option key when you create the
document. For more information on stationery, see “Using Stationery to

Automate Your Work™ on page 2-20.
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J.

Click OK.

The new document opens on the desktop. If you open a word processing
document, ClarisWorks names it Untitled 1 (WP). The letters “WP” 1n the
name stand for word processing. If you create another type of document,
you see these initials: DR (draw), PT (paint), SS (spreadsheet), DB
(database), or CM (communications).

ClarisWorks numbers documents in the order in which you create them.
Numbering begins with the first document you create after you open
ClarisWorks. If you quit and then reopen the application, document
numbers begin again at 1. If you open stationery, it is numbered just like a -
plain new document.

You can give a document a new name when you first save it. For details,
see “Saving a Document” on page 2-6.

Tip In the New Document dialog box, you can use the arrow keys or the
Tab key (Shift-Tab to move backwards) to move the selection from one
type of document to another. Or, you can press Command-1 to select Word
Processing, Command-2 to select Drawing, and so on, up to Command-6.
You can also double-click a button to open a document quickly.

When ClarisWorks Is Running

To create a document when ClarisWorks 1s already running:

1.

J.

Choose New from the File menu (or press Command-N).

You see the New Document dialog box (shown 1n the previous section).

Select the type of document you want. Or, if you want to open a new copy of a stationery
document, choose from the Stationery pop-up menu.

Click OK.

Opening a Document

When you open a document, 1t 1ooks just as it did when you last saved it. You
can open a document from the desktop or from within ClarisWorks.

If you want to open a document created in a previous version of ClarisWorks,
see “From an Earlier Version of ClarisWorks” on page 2-6.



From the Desktop

To open a ClarisWorks document from the desktop, double-click its document
1icon. ClarisWorks starts up (if it’s not already running) and opens the document.

From Within ClarisWorks

To open a document from within ClarisWorks:

p-

ClarizWwaorks thoc:ument
Document icon

1. Choose Open from the File menu (or press Command-0).

You see the Open dialog box.

Document Type File Type
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2. Select the name of the document or stationery you want, and click Open (or double-click the
document name).

You can use the scrolling list, the pop-up menu above the list, and the Eject
and Desktop buttons to locate the document. Refer to the documentation
that came with your Macintosh 1f you need help.

Use the pop-up menus at the bottom of the dialog box to change what type
of documents you see in the list of available documents. You can also use
these choices to open a document created in another application. For

more information, see “Importing, Inserting, and Exporting Documents™

on page 2-14.

¢ Tip If you have a lot of documents, you can use the pop-up menus to hide
document names you don’t need to see. For example, 1f you know you want
to open a database document, choose Database from the Document Type
pop-up menu to show only database documents. (You can also press
Command-1, -2, -3, -4, -5, or -6 to choose a document type.)
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The document opens. You can open as many documents as memory allows.
If your computer doesn’t have enough memory to open a document,
ClarisWorks displays a message to let you know.

¢ Tip If you see a low memory message when you open a document, try
increasing the amount of memory allocated to the ClarisWorks application.
For more information, see the ClarisWorks Installation Guide.

From an Earlier Version of ClarisWorks

The first time you open a document saved in an earlier version of ClarisWorks,
you see a message that ClarisWorks 1s converting the document to the new

version. You see this message only once—until the next time you start up
ClarisWorks.

To cancel the conversion, close the document without saving it. To complete
the conversion, save the document. ClarisWorks adds the suffix [v2.0] to the
new document’s name. Saving under this name (or another new name) leaves
you with two documents: the new version with its new name, and the original.

Saving a Document

When you work with ClarisWorks documents, you follow a routine of opening
a new document, working on it, and storing 1t on a disk.

A document resides temporarily in the computer’s memory as you work. If you
switch the computer off or experience a power failure, you lose any work since
the last time you saved the document. To protect a document, you must save it.
Try to save your work often.

You use the Save command to update an active document on a disk with the most
recent changes you’ve made. When you want to make a copy of a document with
the changes, and you also want to keep the original document unchanged, use the
Save As command to give the new version a different name or location.

You can also save a document as stationery. For more information, see “Using
Stationery to Automate Your Work™ on page 2-20. For information on saving
a document 1n another format for use in a different application, see “Exporting
a Document” on page 2-18.

The First Time

When you save a new document the first time, you also have a chance to name it.



Current location

To save and name a document:

1. Make sure the document you want to save is active (click anywhere in the document).

2. (hoose Save from the File menu (or press Command-S).

You see the Save As dialog box.

Save As pop-up menu
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3. Choose another folder or disk if you want to save the document in a different location.

Y ou can use the scrolling list, the pop-up menu above the list, and the Eject
and Desktop buttons to find a location. Refer to the documentation that

came with your Macintosh 1f you need help.

4. Type a name for the new document in the Save As box.

You don’t need to delete the “Untitled 17 text first; you can just start typing
to replace the selected text in the box.

5. Click Save.

The document’s new name appears at the top of the window where
“Untitled” was before.

As You Work

To save a document you’ve previously saved, choose Save from the File menu
(or press Command-S). ClarisWorks saves any changes you've made since you
last saved the document and leaves the document open.

Under a Different Name

Saving a document under a different name 18 useful when you want to make
changes and also retain a copy of the original document.
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To save a document under a different name:
1. Make sure the document you want to save is active (click anywhere in the document).

2. Choose Save As from the File menu (or press Command-Shift-S).

You see the Save As dialog box.

3. Choose another folder or disk if you want to save the document in a difterent location.

Y ou can use the scrolling list, the pop-up menu above the list, and the Eject
and Desktop buttons to find a location. Refer to the documentation that
came with your Macintosh 1f you need help.

4. Type a new name for the document.

5. Click Save.

ClarisWorks makes a copy of the document using the new name, complete
with any changes you’ve made since the last time you saved. The newly named
document stays open on the screen. The original closes and keeps the old name.

Making a Backup Copy

A backup copy 1s a duplicate of a document that you save on a different disk,
usually a 3.5-inch disk. Making a backup copy protects you against loss of a
document 1f a disk or disk drive fails.

¢ Note Occasionally you may see a message that tells you there isn’t enough
room on the disk to hold the document you want to save. If the disk is full,
you must save the document elsewhere. Switch disk drives or eject the
current disk and insert another.

On a Floppy Disk

To make a backup copy of a document on a 3.5-inch disk:

I. Insert the backup disk into the 3.5-inch disk drive.

o Tip To keep activities straight, add the initials BU (for backup) to the name
of the backup disk.

2. Open the backup disk by double-clicking its icon on the desktop.

3. Select the ClarisWorks document icon, drag it to the window for the backup disk, and release
the mouse button.

It a document with the same name already exists on the disk, you see a

message. Click OK 1f you want to replace the existing backup document
with the current document.



On a Hard Disk

To make a backup copy of a document on a hard disk:

1. Open the hard disk by double-clicking its icon on the desktop.

2. Select the document icon, drag it to the window for the hard disk, and release the mouse
button. If you are copying to the same hard disk, press Option while dragging.

If a document with the same name already exists on the disk, you see a
message. Click OK if you want to replace the existing backup document
with the current document.

Returning to the Last Saved Version

If you make changes but decide not to keep them, you can return a document
to the last saved version. ClarisWorks removes any changes you’ve made since
you last saved the document, and you see the document as 1t was last saved.

Returning to the last saved version of a document 1s useful if you have
experimented with changes and don’t want to undo each change by hand.

To return to the last saved version, choose Revert from the File menu. -
ClarisWorks asks you to confirm that you want to discard the latest changes.

Closing a Document

It’s always wise to close documents and windows before you quit ClarisWorks
and before you shut down the Macintosh, because you’ll be less likely to discard

unsaved changes.

To close a document or window:
1. Click anywhere in a document to activate the window.

2. (lick the close box, press Command-W, or choose Close from the File menu.

If you have multiple windows open, the next window 1s activated as soon
as you close the active window.

If you haven’t saved the document or recent changes to 1t, you 're given the
opportunity to save the document.

To close all windows at once, hold down the Option key and choose Close from
the File menu. Or, hold down the Option key and click the close box of the

active window.
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Printing Your Work

Before you try to print a document for the first time, be sure your printer 1s set
up properly:
= Is the printer plugged in and switched on?

= Is the cable from the printer to the Macintosh inserted in the proper
Macintosh port?

= Do you have paper in the tray (LaserWriter, StyleWriter) or at the top of a
form (ImageWriter)?

« If your printer has a Select or On Line light, 1s it on?

= Is the Chooser properly set? (See the next section.)

Choosing a Printer

When you first use your printer, or when you change printers, you need to
identify the printer to the Macintosh system software. You do this with the
Chooser desk accessory. These instructions summarize the steps. For complete
information, and for information on using the Chooser on a network, see the
manual that came with your printer.

[f you've already set Chooser options for your printer while working in another
application, you don’t have to redo the steps.

To choose a printer:

1. Choose Chooser from the Apple menu.

You see the Chooser window.
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2. Select your printer type, choose a printer name, and set the options you want for Background
Printing and AppleTalk.

The options vary with your printer.

3. (lick the close box (or choose Close from the File menu).

The printer has now been identified by the Macintosh. You don’t have to
repeat this process until you change printers.

Preparing to Prinf

Most printers are preset to print on 8.5-by-11 inch paper, using vertical
orientation (the long way), and 100% scaling. Before you print a document,
you can change these options.

The tollowing instructions describe how to print with a LaserWriter. If you
have a different printer, some procedures may be different. See the manual that
came with your printer.

¢ Tip If you are using a LaserWriter or high-resolution printer, you can select
Fractional Character Widths in the Text options of the Preferences dialog
box. Doing so provides finer character spacing in the printed document,
improving 1ts appearance. You may also notice that characters appear
closer together on the screen. For more information on setting preferences,
see “‘Setting Preterences” on page 2-52.

To prepare to print:
1. Choose Page Setup from the File menu.

You see the Page Setup dialog box. The specific options shown may vary
slightly because the Macintosh automatically changes the options to match
the printer i1t’s connected to. For additional details, see the manual that

came with your printer.
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2. Select a paper size.

_..F".‘s

— ][

U.S. Letter is 8.5 inches wide, 11 inches tall. U.S. Legal is 8.5 inches wide,
14 inches tall. Tabloid 1s 11 inches wide, 14 inches tall. A4 European
Standard is 8.25 inches wide, 11.66 inches tall. B5 International Standard
1s 8.25 inches wide, 12 inches tall. For more information on paper sizes and
the printable area on a sheet of paper, see the documentation that came with
your Macintosh and printer.

If you want to reduce or enlarge the document when you print, type a percentage in the
Reduce or Enlarge box.

Actual size 1s 100%. Percentages less than 100 reduce the image, and
percentages greater than 100 enlarge it. For example, 75% reduces the
image to 75% of actual size, 125% enlarges the image to 125% ot actual
size. You can use any percentage from 25% to 400% on the LaserWriter.
The percentage range varies on other printers.

Select one of the Orientation icons for a vertical (portrait) page or a horizontal
(landscaped) page.

Orientation

I

il

— L

Vertical page Horizontal page

5. Select any options you want in the Printer Effects list.

Font Substitution causes all instances of the Geneva, New York, and
Monaco fonts to print as Helvetica, Times, and Courier, respectively.

Text and Graphics Smoothing options help minimize jagged edges on

graphic images and on Macintosh screen fonts that have no corresponding
printer fonts.

Faster Bitmap Printing generally speeds up the printing of documents that
contain graphic images such as those produced in the paint environment. If

you have trouble printing a document that contains these images, try
turning off this option.

Note On an ImageWriter, No Gaps Between Pages sets the printer to print
across a page break, for example when printing labels.



6. (lick OK.

You 're now ready to print the document. For more information, see
“Printing a Document,” next.

¢ Tip Only the current, open document is affected by changes you make in
the Page Setup dialog box. You can, however, save the document as
ClarisWorks stationery and preserve the settings for future use. For more
information, see “Using Stationery to Automate Your Work” on page 2-20.

Printing a Document

Betfore you print a document, you must identify a printer (see “Choosing a
Printer” on page 2-10). It you want to change any of the preset page options,
see “‘Preparing to Print” on page 2-11.

Most printers are preset to print one copy of a document, all pages, no cover
page, and on paper ted automatically from the paper cassette. For a detailed
description of options in the Print dialog box, see the documentation that came

with your Macintosh.

¢ Note When you print a paint document (or a document with a paint frame)
that contains color images to an ImageWriter II with a color ribbon, the
images print 1n shades of gray.

To print a document:

1. With the document open, choose Print from the File menu (or press Command-P).

Y ou see the Print dialog box. The dialog box looks different if you’re using
a printer other than a LaserWriter.
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2. In the Copies text box, type the number of copies you want.
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3. If you want fo print only part of the document, type page numbers in From and To.

To print just one page, type the same page number in both text boxes.
4. If you are printing a document that contains color or grayscale, select Color/Grayscale.
5. Click Print.

ClarisWorks prints the document.

¢ Note If you're printing a spreadsheet or database document, the Print

dialog box gives you additional options. For a spreadsheet, you can choose
not to print row and column headings and the cell grid. For a database, you
can print the current record or all visible records. If you plan to print labels
from a database document on an ImageWriter, don’t use a header part 1n
your label layout. Also, click the No Gaps Between Pages option in the
Page Setup dialog box. (For more information on printing labels, see
“Creating Labels” in chapter 7 and appendix C, “Printing Labels.”)

To print a document using the current print settings, hold down the Option key
and choose Print from the File menu.

Importing, Inserting, and Exporting Documents

Y ou can share ClarisWorks documents with other applications in several ways.
[t you want to work with a document created in another application, you can
simply open the document from within ClarisWorks. Doing so 1s known as
importing. When you import a document, you make a copy of it in the
ClarisWorks file format and work with that copy. (File format refers to the
way an application organizes and stores the contents of a document.)

You can also insert a document into a ClarisWorks document. Inserting places
the entire contents of a document created in another application into an existing
ClarisWorks document. No new document 1s created; but like importing, the
other application’s document remains intact in its original format.

If you want to use a ClarisWorks document in another application, you can
save 1t 1n that application’s file format. Doing so is known as exporting.

Exporting 1s the opposite of importing—you create a copy of the ClarisWorks
document 1n the other application’s file format.



To share documents with other applications, the ClarisWorks application uses
programs called translators. These translators change the file format of a non-
ClarisWorks document into the ClarisWorks file format, or a ClarisWorks
document into a file format another application can use. Before you import,
insert, or export a document, be sure the appropriate translators are installed.
For information on installing translators, see the ClarisWorks Installation
Guide. For more information about the file formats you can use with
ClarisWorks, see appendix B, “Sharing Documents with ClarisWorks.”

Importing a Document S

Import a document when you want to work with it in one of the ClarisWorks
application environments. The changes you make only affect the ClarisWorks
document—the other application’s copy 1s untouched.

¢ Note To import an AppleWorks® or AppleWorks GS document, you must
first translate your ProDOS file to Macintosh format. You can do so using
the Apple File Exchange utility that came with your Macintosh, or an
AppleTalk network. If you are using a Macintosh LC or LCII and have
installed the Apple Ile card, you can insert an Apple 3.5-inch diskette into
the floppy disk drive and open the document directly. If your data 1s stored
on a 5.25-inch diskette instead, you must first transfer the data to the
Apple II partition of your hard disk betore you can open the documents
from within ClarisWorks (please refer to the manual that came with the
Apple Ile card). For more information on using Apple File Exchange or
AppleTalk, see the documentation that came with your Macintosh.
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To import a document from another application:

1. Within ClarisWorks, choose Open from the File menu.

You see the Open dialog box.

— Hard Disk

D Contacts _
[ Quarterly Report [ £ el
) Sales Performance | [ Deskion \

(_Open |
| [ Cancel ]

Document Type File Type

‘FIII Types VI ‘FIII Clarislorks vl

2. Choose the type of document you want to import (for example, draw or spreadsheet) from

v All Types #0 :
s ot the Document Type pop-up menu.
2;?,?:;:3 ;é The list of available documents changes to show only documents of the
Database #*4 tvoe vou chose.
Spreadsheet 35 4 2
Communications 36

¢ Note All Types shows documents in the ClarisWorks format only. To

Document Type
po;?up menzp import a QuickTime movie, choose Drawing.

3. (Choose a file format from the File Type pop-up menu.

The list of available documents changes to show only documents in the file
format you chose. What you see 1n this pop-up menu depends on which

v All ClarisWorks translators you have installed and what 1s selected in the Document Type pop-
ClarislWorks : . . : :
Stationery up menu. (For more information, see the ClarisWorks Installation Guide.)

File Type pop-up menu 4. Select the name of the document you want and click Open (or double-click the name).

You can use the scrolling list, the pop-up menu above the list, and the Eject
and Desktop buttons to locate the document. Refer to the documentation
that came with your Macintosh it you need help.

ClarisWorks opens the document and adds the word Converted to the title.
You see a progress message as the conversion takes place.
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¢ Tip If you want to open a document from an application that isn’t listed, try
this: open the document in the other application and save it in a format that’s
compatible with a ClarisWorks translator. (This process is sometimes called
“saving out.”) For example, if a spreadsheet application supports SYLK
format, you can save the spreadsheet in SYLK format. You can then open it
as a ClarisWorks document.

Inserting a Document

You can 1nsert an entire document saved 1n another format into a ClarisWorks
document 1n one step. Inserting a document eliminates the need to open another
document, copy its contents, and return to the original document to paste the
contents.

¢ Note Inserting data into a database document requires steps not covered in
this section. For more information, see “Inserting Database Documents
from Other Applications™ in chapter 7.

To insert a document:

I. Inthe receiving document, determine where you want the insert to appear. ¢

In a draw document, ClarisWorks places the insert where you last clicked
in the window. In a paint document, ClarisWorks places the insert in the
middle of the working area. In a text document or frame, ClarisWorks
places the 1nsert at the insertion point.

2. Choose Insert from the File menu.

You see the Insert dialog box.
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The scrolling list shows only the documents in a format that you can 1nsert
into the current document.

3. (Choose the document type from the Show pop-up menu.

The list of available documents changes to show only documents of the
type you chose.

4. Select the name of the document you want to insert and click Insert (or double-click the
document or filename).

Y ou can use the scrolling list, the pop-up menu above the list, and the Eject
and Desktop buttons to locate the document. Reter to the documentation
that came with your Macintosh 1t you need help.

You see the contents of the insert in your ClarisWorks document.

¢ Note You can also insert data into a spreadsheet or database document
by copying and pasting the data. Before you paste data into a database
document, press the Enter key to exit the current field. When you paste data
from one ClarisWorks database to another, ClarisWorks ensures that data
1s pasted 1nto the correct fields by matching field names. If these elements
do not match, ClarisWorks pastes data using the current tab order. If the
database document has fewer fields than the information you are pasting,
ClarisWorks 1gnores the extra information.

Exporting a Document

Export a document when you want to open it in an application other than
ClarisWorks. When you export a document, you end up with two copies:
the original ClarisWorks document and a copy in another file format.



Exported Report

To export a document:

1. Choose Save As from the File menu.

You see the Save As dialog box.
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2. Find the disk and folder in which you want to save the exported document.

You can use the scrolling list, the pop-up menu above the list, and the Eject
and Desktop buttons to find a location. Refer to the documentation that

came with your Macintosh 1f you need help.
3. Type a name for the exported document.
4. Choose the file format type from the Save As pop-up menu.
5. (Click Save.

The document 1s stored, with the new name, in the folder and on the disk
you specified.

¢ Tip If an application you want to use isn’t listed in the Save As pop-up
menu, you can sometimes use one of the commo<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>